The fastest, easiest, most comprehensive way to learn Adobe Premiere Elements 12

Classroom in a Book®, the best-selling series of hands-on software training workbooks, offers what no other book or training program does—an official training series from Adobe Systems Incorporated, developed with the support of Adobe product experts.

Adobe Premiere Elements 12 Classroom in a Book contains 12 lessons that cover the basics, providing countless tips and techniques to help you become more productive with the program. You can follow the book from start to finish or choose only those lessons that interest you.

Purchasing this book gives you access to the downloadable lesson files you need to work through the projects in the book, and to electronic book updates covering new features that Adobe releases for Creative Cloud customers. For access, go to www.peachpit.com/redeem and redeem the unique code provided inside this book.

What you need to use this book: Adobe Premiere Elements 12 software, for either Windows or Mac OS. (Software not included.)

Note: Classroom in a Book does not replace the documentation, support, updates, or any other benefits of being a registered owner of Adobe Premiere Elements 12 software.

"The Classroom in a Book series is by far the best training material on the market. Everything you need to master the software is included: clear explanations of each lesson, step-by-step instructions, and the project files for the students."

Barbara Binder, Adobe Certified Instructor
Rocky Mountain Training
CONTENTS

GETTING STARTED 1

About Classroom in a Book ........................................ 1
Prerequisites ............................................................... 2
Installing Adobe Premiere Elements 12 ................................. 3
Accessing the Classroom in a Book files ............................... 3
Additional resources ....................................................... 4

1 THE WORLD OF DIGITAL VIDEO 6

How Adobe Premiere Elements fits into video production .............. 8
The Adobe Premiere Elements workspace ................................ 9
Working in Adobe Organizer .............................................. 11
What’s new in Adobe Premiere Elements 12 ............................. 23
Review questions and answers ............................................. 25

2 GETTING READY TO EDIT 26

Setting startup preferences ............................................... 28
Setting up a new project ................................................... 29
Working with project preferences .......................................... 38
Customizing the workspace .................................................. 41
Review questions and answers ............................................. 43

3 VIDEO CAPTURE AND IMPORT 44

Capturing video with Adobe Premiere Elements ........................ 46
Capture interfaces ............................................................ 47
Using the Video Importer ...................................................... 48
Capturing tape-based or live video .......................................... 53
Capturing with the Capture panel ......................... 57
Importing content from your hard drive ................. 60
Review questions and answers ............................. 61

4 ORGANIZING YOUR CONTENT .......................... 62
  Getting started .......................................... 64
  Viewing the completed movie before you start ......... 64
  Working in the Project Assets panel .................... 65
  Tagging in the Organizer ................................. 70
  From the Organizer to Adobe Premiere Elements ........ 84
  Review questions and answers .......................... 89

5 EDITING VIDEO ........................................ 90
  Getting started .......................................... 92
  Watching the guided edit ................................ 92
  Viewing the completed movie before you start ......... 93
  Working in the Monitor panel ............................ 93
  Editing in Quick view ................................... 97
  Using the Split Clip tool in Quick view ................. 103
  Working in Expert view .................................. 104
  Editing in Expert view ................................... 106
  Using the Split Clip tool in Expert view ................ 112
  Working in Smart Trim mode .............................. 115
  Review questions and answers ........................... 119

6 WORKING WITH EFFECTS .............................. 120
  Getting started .......................................... 122
  Viewing the completed movie before you start ......... 122
  Using effects ............................................ 123
  Working with Smart Fix .................................. 127
Perfecting your clips ...................................................... 129
Working with Auto Smart Tone ........................................ 130
Stabilizing shaky footage ................................................. 137
Previewing and rendering effects .................................... 139
Working with Time Remapping ......................................... 141
Reframing content with Motion controls .............................. 146
Changing playback speed ............................................... 149
Creating a Pan & Zoom effect ........................................... 151
Working with keyframes .................................................. 156
Applying effects to multiple clips ..................................... 163
Creating a Picture-in-Picture overlay .................................. 170
Compositing two clips using Videomerge .............................. 172
Working with Motion Tracking ......................................... 174
Exploring on your own .................................................... 176
Review questions and answers .................................... 177

7  CREATING TRANSITIONS 178
Getting started ............................................................... 180
Viewing the completed movie before you start ...................... 180
Working with transitions ............................................... 181
Exploring on your own .................................................... 194
Review questions and answers .................................... 195

8  ADDING TITLES AND CREDITS 196
Working with titles and title-editing mode .......................... 198
Getting started ............................................................... 198
Viewing the completed movie before you start ...................... 199
Titles and text overview ................................................ 199
Creating a simple full-screen title ..................................... 202
Modifying title text ......................................................... 203
Superimposing a title over video clips ................................ 211
Using graphics .............................................................. 215
Working with animated titles ............................................. 217
Exploring on your own .................................................. 220
Review questions and answers ........................................ 221

9  WORKING WITH SOUND .............................................. 222

Getting started .......................................................... 224
Viewing the completed movie before you start .................. 224
Quick view or Expert view? ............................................. 225
Workflow overview ..................................................... 226
Adding background music with scores .............................. 226
Adding narration ......................................................... 227
About waveforms ....................................................... 228
Adjusting audio volume .............................................. 230
Volume, gain, or normalize? ......................................... 233
Adjusting project volume with Smart Mix ......................... 234
Exploring on your own .................................................. 240
Review questions and answers ....................................... 241

10  CREATING MENUS .................................................. 242

Getting started .......................................................... 244
Understanding DVD, Blu-ray, and AVCHD discs, plus web DVDs .................................................. 246
Manually adding scene markers ...................................... 248
Creating an auto-play disc ............................................. 250
Automatically generating scene markers ......................... 251
Creating a disc with menus .......................................... 253
Modifying Scene Marker buttons .................................. 257
Adding submenus and menu links to bonus clips .............. 259
Customizing menus with video, still images, and audio ...... 263
Animating buttons ...................................................... 265
Changing menu button text properties ............................ 268
Creating web DVDs .................................................... 271
Burning DVD, Blu-ray, and AVCHD discs .................... 274
Review questions and answers ............................. 277

11 SHARING MOVIES ........................................ 278
Sharing and exporting video .................................. 280
Getting started ................................................. 280
Viewing the completed movie for the first exercise ........ 281
Uploading to YouTube ........................................ 281
Sharing on your personal computer ......................... 284
Exporting to mobile phones and players ................... 289
Exporting a frame of video as a still image ................. 291
Review questions and answers .............................. 293

12 WORKING WITH ADOBE PHOTOSHOP ELEMENTS ...... 294
Viewing the completed movie before you start ............ 296
Getting started ................................................. 296
Creating a new Photoshop file optimized for video ....... 299
Customizing a title in Adobe Photoshop Elements .......... 300
Editing a Photoshop image in Adobe Photoshop Elements ........................................... 306
Review questions and answers .............................. 308

INDEX .......................................................... 309
Adobe® Premiere® Elements 12 delivers video editing tools that balance power and versatility with ease of use. Adobe Premiere Elements 12 is ideal for home users, hobbyists, business users, and professional videographers—anyone who wants to produce high-quality movies and DVDs.

If you’ve used earlier versions of Adobe Premiere Elements, you’ll find that this Classroom in a Book covers the updated interface that Adobe Systems introduced in this version, plus new advanced skills and features. If you’re new to Adobe Premiere Elements, you’ll learn the fundamental concepts and techniques that will help you master this application.

About Classroom in a Book

Adobe Premiere Elements 12 Classroom in a Book is part of the official training series for Adobe graphics and publishing software developed by Adobe product experts. Most lessons in this book include self-paced projects that give you hands-on experience using Adobe Premiere Elements 12. You will almost certainly get the most benefit from working on the lessons in the order in which they occur in the book.

As an overview, in the first two lessons, you’ll learn your way around Adobe Premiere Elements and the Adobe Organizer, how to set up a project in Adobe Premiere Elements, and how to customize critical preferences.

In Lesson 3, you’ll learn how to capture and otherwise import video into Adobe Premiere Elements. Starting with Lesson 4, you’ll open provided projects or create your own from provided contents, and learn how to convert your raw, captured clips into a polished movie.

Note that the project files were created separately for Mac and Windows computers, and were created using prerelease software and content. For this reason, there may be some minor differences between the figures in the book and what you might see onscreen when you’re using Adobe Premiere Elements. Throughout the book, we’ve tried to identify the places you’re most likely to see this, but apologize in advance for any differences or inconvenience.
Prerequisites

Before you begin working on the lessons in this book, make sure that you and your computer are ready.

Requirements for your computer

You'll need a maximum of about 4.3 gigabytes (GB) of free space on your hard drive for the lesson files and the work files you'll create. For some lessons, you'll need to have 2GB of RAM installed on your computer. Note that the lessons assume that you have installed all templates and associated content available with the DVD version of Adobe Premiere Elements 12 or via download. If the lesson calls for a template or other content that's not installed on your computer, Adobe Premiere Elements should download it automatically. If this doesn’t occur, you should be able to simply choose another template and continue with the lesson.

Required skills

The lessons in Adobe Premiere Elements 12 Classroom in a Book assume that you have a working knowledge of your computer and its operating system. This book does not teach the most basic and generic computer skills. If you can answer yes to the following questions, you’re probably well qualified to start working on the projects in these lessons:

• Do you know how to use the Microsoft Windows Start button and the Windows task bar? On the Mac, do you know how to run applications from the Dock or in the Applications folder? In both operating systems, can you open menus and submenus, and choose items from those menus?

• Do you know how to use My Computer, Windows Explorer, Finder, and/or a browser—such as Chrome, Firefox, Internet Explorer, or Safari—to find items stored in folders on your computer, or to browse the Internet?

• Are you comfortable using the mouse to move the pointer, select items, drag, and deselect? Have you used context menus (which open when you right-click items in Windows or Mac OS, or Control-click items on the Mac if you’re working with a single-button mouse)?

• When you have two or more open applications, do you know how to switch from one to another? Do you know how to switch to the Windows or Macintosh desktop?

• Do you know how to open, close, and minimize individual windows? Can you move them to different locations on your screen? Can you resize a window by dragging?

• Can you scroll (vertically and horizontally) within a window to see contents that may not be visible in the displayed area?
• Are you familiar with the menus across the top of an application and how to use those menus?

• Have you used dialog boxes (special windows in the interface that display information), such as the Print dialog box? Do you know how to click arrow icons to open a menu within a dialog box?

• Can you open, save, and close a file? Are you familiar with word processing tasks such as typing, selecting words, backspacing, deleting, copying, pasting, and changing text?

• Do you know how to open and find information in Microsoft Windows or Apple Macintosh Help?

If there are gaps in your mastery of these skills, see the documentation for your operating system. Or, ask a computer-savvy friend or instructor for help.

### Installing Adobe Premiere Elements 12

Before you begin using *Adobe Premiere Elements 12 Classroom in a Book*, make sure that your system is set up correctly and that you’ve installed the required software and hardware. You must purchase the Adobe Premiere Elements 12 software separately. For system requirements and complete instructions on installing the software, visit [www.adobe.com/support](http://www.adobe.com/support).

### Accessing the Classroom in a Book files

In order to work through the projects in this book, you will need to download the lesson files from peachpit.com. You can download the files for individual lessons, or download them all in a single file.

Your Account page on peachpit.com is where you’ll find any updates to the chapters or to the lesson files. Look on the Lesson & Update Files tab to access the most current content. To access the Classroom in a Book files, do the following:

1. Go to [www.peachpit.com/redeem](http://www.peachpit.com/redeem), and enter the code found at the back of your book.

2. If you do not have a Peachpit.com account, create one when you’re prompted to do so.

3. Click the Lesson & Update Files tab on your Account page. This tab lists downloadable files.

4. Click the lesson file links to download them to your computer.

5. Create a new folder on your hard disk, and name it Lessons. Then, drag the lesson files you downloaded into the Lessons folder on your hard disk.
Additional resources

*Adobe Premiere Elements 12 Classroom in a Book* is not meant to replace documentation that comes with the program or to be a comprehensive reference for every feature. Only the commands and options used in the lessons are explained in this book. For comprehensive information about program features and tutorials, please refer to these resources:

**Adobe Premiere Elements 12 Help and Support:** Point your browser to helpx.adobe.com/premiere-elements.html, where you can find and browse Help and Support content on adobe.com.

**Adobe Forums:** forums.adobe.com lets you tap into peer-to-peer discussions and questions and answers on Adobe products. forums.adobe.com/community/premiere_elements takes you to the forum for Adobe Premiere Elements.

**Adobe TV:** tv.adobe.com is an online video resource for expert instruction and inspiration about Adobe products, including a How To channel to get you started with your product.

**Resources for educators:** www.adobe.com/education.edu.html offers a treasure trove of information for instructors who teach classes on Adobe software. Find solutions for education at all levels, including free curricula that use an integrated approach to teaching Adobe software and can be used to prepare for the Adobe Certified Associate exams.

**Adobe Premiere Elements 12 product home page:** www.adobe.com/products/premiere-elements.html

**Free trial versions of Adobe Photoshop Elements 12 and Adobe Premiere Elements 12:** The trial version of the software is fully functional and offers every feature of the product for you to test-drive. To download your free trial version, browse to www.adobe.com/downloads.html.
This page intentionally left blank
Lesson overview

Fast and efficient movie production requires organization before and during the edit. When you’re working with content from multiple sources and dates, Adobe Organizer is a very powerful tool for categorizing content and quickly finding video, audio clips, and pictures to use in your projects. In this lesson, you’ll learn how to do the following:

- Create places in the Organizer and associate your content with those places
- Use Smart Events to quickly find content from specific dates
- Create events in the Organizer and associate your content with those events
- Rate your clips and find clips based on those ratings
- Create and use keyword tags to find your content
- Use the Auto-Analyzer to split your video into scenes and rate it qualitatively
- Transfer clips from the Organizer to Adobe Premiere Elements

This lesson will take approximately two hours. Download the project files for this lesson from the Lesson & Update Files tab on your Account page at www.peachpit.com and store them on your computer in a convenient location, as described in the Getting Started section of this book. Your Account page is also where you’ll find any updates to the chapters or to the lesson files. Look on the Lesson & Update Files tab to access the most current content.
Geotagging content in the Organizer
Getting started

Before you start working with the footage, let’s review a final version of the movie you’ll be creating. Make sure that you have correctly copied the Lesson04 folder from your Account page onto your computer’s hard drive. See “Copying the Classroom in a Book files” in the Getting Started section at the beginning of this book.

1 Launch Adobe Premiere Elements. If it is already open, choose Help > Welcome Screen in the Adobe Premiere Elements main menu to return to the Welcome screen.

2 In the Welcome screen, click Video Editor, select Existing Project, and click the Open icon.

3 In the Open Project dialog box, navigate to the Lesson04 folder you copied to your hard drive. Within that folder, select Lesson04_Start_Win.prel (Windows) or Lesson04_Start_Mac.prel (Mac OS), and then click Open. If a dialog box appears asking for the location of rendered files, click the Skip Previews button. Your project file opens.

4 Choose Window > Restore Workspace to ensure that you start the lesson with the default panel layout.

Viewing the completed movie before you start

To see what you’ll be creating in this lesson, take a look at the completed movie. You must be in Expert view to open the Project Assets panel to view the movie; if you are not, click Expert at the top of the Monitor panel (Expert) to enter that view.

1 At the upper left side of the Adobe Premiere Elements window, click the Project Assets button (Project Assets) to open that panel. Locate Lesson04_Movie.mov (which should be the only file), and then double-click it to open the video into the preview window.

2 Click the Play button to watch the video about a boat ride in the bayou, which you’ll build in this lesson.

3 When you’re finished, close the preview window.
Working in the Project Assets panel

The Project Assets panel contains all the content that you've input into your project, and is available only in Expert view. As with all panels, you click the Project Assets button (Project Assets) to open it, and then click the button again to close it.

The Project Assets panel's role is to help you organize and find files using different search methods. Let's load some files into the project so you can work with them in the Project Assets panel.

Loading files in the Project Assets panel

Again, if you don't see the Project Assets panel, click Expert at the top of the Monitor panel (Expert) to enter that view.

1. Click Add Media (Add Media) to open the Add Media panel.
2. Click Files And Folders (Folder) to open the Add Media dialog box.
3. Navigate to the Lesson04 folder. While pressing the Ctrl key (Windows) or Command key (Mac OS), select the movie clips Gator01.mp4 to Gator16.mp4, all digital pictures from Picture 1.jpg to Picture 8.jpg, and the single audio clip, narration.wav. Then click Open (Windows) or Import (Mac).
Controls in the Project Assets panel

You can use controls in the Project Assets panel to create titles, black videos, bars and tones, and color mattes. In this section, you'll learn how to use the basic tools in the Project Assets panel to find the desired file.

You can do either of the following in the Project Assets panel to view your files:

- Grab the handle on the extreme lower right of the panel to expand it vertically and horizontally.
- Browse through the entire catalog by using the scroll bar at the right side of Project Assets panel.

Let's work through some of the most common functions of the Project Assets panel.

At the upper left of the Project Assets panel, experiment by clicking the Show/Hide Video (A), Show/Hide Still Image (B), and Show/Hide Audio (C) buttons. For example, click the Hide Still Image and Hide Audio buttons so only video files appear in the Project Assets panel. This is a very simple technique for quickly finding the video content that you're looking for.
2 From the Project Assets panel menu, choose View > List View to display the content in this view. Once in List view, click and drag the bottom right corner to expand the window so all the columns are visible. You can sort your content by clicking the column head of any column. The arrow in the column you choose shows whether the data is sorted in ascending or descending order. For example, click the Name column head to see how it sorts the content, and then click the Media Duration column head. The column with the arrow showing is the column currently being used to sort the content.

3 In the Project Assets panel menu, choose New Folder to create a folder to organize your videos. Adobe Premiere Elements creates a folder named Folder 01, with the text highlighted so it’s easy to change the name. Type in the word Video and press Enter or Return, replacing the default name Folder 01.

4 Select all video files, and drag them into the new folder. Click the triangle next to the Video folder to close it. Now your Project Assets panel is a whole lot tidier. When you’re working with large projects with multiple video, still image, and audio files, creating folders is the best strategy for organizing your content and making it easy to find.
5 From the Project Assets panel menu, choose New Item to view the new items that you can create from this menu. We'll cover adjustment layers in Lesson 6 and titles in Lesson 8. Bars And Tone is a vestigial concept that is useful for analog projects but has little application for most digital video-based projects. Creating black video and color mattes is useful when you need colored or black backgrounds for titles or other movie elements. When you choose any of these items, Adobe Premiere Elements will open a format-specific dialog box for creating the content and inserting it into the Project Assets panel.

![Project Assets Panel](image1)

6 Double-click Gator01.mp4 in the Videos folder of the Project Assets panel to open it in the preview window. (If necessary, click and drag the bottom-right corner of the Project Assets panel to make the preview window visible.) The preview window lets you play your content using VCR-like controls before you add it to your project. You can also trim frames from the start and end of a video before adding it to your project. Although you can also trim frames in the timeline, you may prefer to do this in the preview window.

7 Trim a few frames from the clip: In the Preview window, drag the current-time indicator (CTI) to the right until the timecode beneath the video reads 00;00;00;22, which is 22 frames in from the start of the clip and the point at which the zoom-in starts. Note that you can also use the Left and Right Arrow keys on your keyboard for precise positioning of the current-time indicator.

![Preview Window](image2)

8 Click the Set In icon ( ) to set the In point, or press the letter I on your keyboard. In essence, you’ve told Adobe Premiere Elements to ignore the first 22 frames when you add the clip to the project, and to start at frame 23. Of course, the edit is nondestructive, so you haven’t actually deleted any frames from the video file on your disk. You can always undo this later and show the frames that you just trimmed.

---

**Note:** On Windows, you can also create a Universal Counting Leader—a vestigial feature typically used only when writing video back to analog tape.

---

**Note:** Rather than moving the CTI to the desired location and choosing Set In point or Set Out point, you can simply drag the In point handle or Out point handle to the desired location.
In the Preview window, drag the current-time indicator to the right until the timecode beneath the video reads around 00:00:02:15, which is where the zoom-in ends. Click the Set Out icon (I) to set the Out point, or press the letter O on your keyboard. You’ve just set the Out point, essentially trimming out all video frames to the right of that point of the video.
10 Click and drag Gator01.mp4 in the preview window to the start of the Video 1 and Audio 1 tracks on the timeline as shown below, and release. You’ve just added the trimmed video to the timeline. Click No if Adobe Premiere Elements asks if you want to fix any quality issues in the clip or any other questions.

11 Close the preview window, and click the Project Assets button ( ) to close the Project Assets panel. Make sure that the current-time indicator in the timeline is at the start of the clip, click anywhere in the timeline, and then press the spacebar to play the clip. Note that it starts and ends on the trimmed frames.

**Note:** When you set In and Out points in the preview window, they’re automatically applied when you drag the clip into the timeline; they aren’t retroactively applied to clips already in the timeline. You’ll learn how to trim clips in the timeline in the next lesson.

Tagging in the Organizer

The Project Assets panel is great for quickly finding clips, but the Organizer is the best tool in Adobe Premiere Elements for serious organization and search-and-retrieval work. You can open the Organizer by clicking the Organizer icon ( ) in Adobe Premiere Elements Action bar. In this exercise, you’ll learn how to perform manual tagging and Smart Tagging in the Organizer, and then how to search for clips using those tags in the Organizer.

Note that the contents of the Organizer will depend upon many circumstances, including which lessons you’ve performed, whether you’ve imported content
into the Organizer from Photoshop Elements, and other factors. To make your Organizer look like the next figure, take the following steps:

1. On the extreme lower left of the Organizer, click the Show icon ( ), which reveals the folders on the upper left. (If Show is already selected, you’ll see the Hide icon in this location.) Click Folder 4, which opens just the contents from that folder in the Organizer. Make sure that you have the Media tab selected on the top to see what’s showing in the figure below.

2. On the extreme lower right of the Organizer, click the Tags/Info icon ( ), which opens the Tags and Information panels on the right of the Organizer’s interface.

3. Choose View > Media Types, and make sure Photos, Video, and Audio are all selected.

4. Choose View > Details.

5. Choose View > File Names.

6. In the Sort By menu at the top of the Media browser, choose Name.

Note: You can play any video file, or view any still image, in the Organizer by double-clicking the video or still image in the browser and then clicking the Play button in the Preview window that appears. Close the window to return to the Media Browser. Still images are displayed in an expanded window in the Media Browser; click Grid ( ) on the left of the toolbar immediately above the image to return to the Media Browser.

Note: Your screen may not match perfectly what’s shown on the page, but the minor differences shouldn’t keep you from completing any exercises.
There are three ways that the Adobe Organizer helps you organize your clips: by categorizing them into People, Places, and Events; by giving them star ratings on a scale from 1 to 5; and by manually tagging them with keywords and via smart tags. We'll give you a quick introduction to each technique, and then you'll learn how to use them all.

In Adobe Premiere Elements 12, the Organizer’s interface has been optimized for three views, as shown on the top toolbar: People, Places, and Events. By associating your video clips with one or more of these categories, you can easily find all clips associated with a person, place, or event. We’ll demonstrate how to associate your clips with a place or an event, but not a person, primarily because face recognition—a great feature that the Organizer uses to automate the process of people tagging your still images—is not available for video.

The star ratings system allows you to review and rate all your clips on a scale from 1 to 5; you can later search for only those clips that you rated 4 or higher, for example—an easy way to find high-quality clips and/or eliminate poor-quality clips.

Keyword tagging allows you to tag a clip by person, location, event, or other classifications, and includes customizable categories.

When you run the Auto-Analyzer on a clip, Adobe Premiere Elements analyzes the video to detect scenes based on content, and rates the content qualitatively, a process known as Smart Tagging. This allows you to hunt for scenes that contain faces and identify scenes that are out of focus, shaky, underexposed, or overexposed. Using this qualitative data, Adobe Premiere Elements then categorizes all clips as high, medium, or low quality. This serves a valuable triage function that later helps you search for the best clips for your movie. This analysis is also used for features like Smart Trimming and Smart Fix, as discussed in Lesson 6.

For example, if you shot an hour of video on your last vacation, Smart Tagging allows you to identify medium-and-higher quality clips containing faces (presumably family members) and to produce a movie containing only these clips. What would literally take you hours to accomplish manually, Smart Tagging can produce in a few moments.

Using all these tags in any combination, you can hunt for clips to manually add to your projects, or you can create an InstantMovie, which is a professional-looking edited movie complete with titles, soundtrack, effects, and transitions. You’ll create an InstantMovie in the last exercise in this lesson.

**Tagging clips to Places**

The content we’re using in this book was shot in two different places: The still images are from New Orleans; the videos from Airboat Adventures in Lafitte, Louisiana.

You’ll use this content to create two Places in the Organizer—one for the videos, the other for the still images—and associate some content with each Place. Then, working from the Organizer’s Google Maps view, you can click a place and see all clips associated with that place.

**Note:** The Adobe Organizer can display all clips in a Timeline view (in Media view, choose View > Timeline) that displays content by date, which can be a convenient way to find some clips. In this view you can click any clumps of sequential clips in the timeline, and they appear in the Media Browser. Of course, you need clips in the Organizer for there to be any clumps, so until you populate the Organizer, this view won’t provide that much value.
1 On the Organizer’s top toolbar, click Places (Places).

2 On the Organizer’s bottom toolbar, click Add Places (Add Places).

3 In the Add Places Search field, type Lafitte Louisiana, and click Search. Note that if you were typing in a street address, you would type in the address as you would on an envelope. For example, if you shot video at the White House in Washington, DC, you could either type in The White House or 1600 Pennsylvania Avenue, NW Washington, DC 20500.

4 In the Organizer, click Lafitte, LA, USA.

5 Hold down the Ctrl key (Windows) or Command key (Mac OS) and, in the media bar at the top of the Add Places dialog box, click all the videos associated with that location. This should total 17 videos: 16 Gator clips and Lesson4_Movie.mov.

6 Release the Ctrl or Command key, and click the green checkmark. Adobe Premiere Elements will associate the selected content with that place.
Lesson 4  Organizing Your Content

7  At the bottom right of the Add Places dialog box, click Done. The Organizer creates the place.

8  Repeat the process for the images. Click Add Places again, type **New Orleans** in the Search field, and click the location that the Organizer finds. Hold down the Ctrl key (Windows) or Command key (Mac OS), select all the images, and then click the green checkmark. Click Done when you’re finished.

You should now have at least two places identified and content associated with each. Let’s see how this will help you find your content for future projects.

In the Organizer’s top toolbar, click **Media** to exit Places view, and then click **Places** to return to that view. If the map isn’t displayed on the right, click the Map icon in the lower right corner of the Organizer window.

You may have to adjust the navigational and sizing controls on the upper left of the map, but you should be able to approximate the view shown above. Double-click either icon, and the Organizer will display the content from that location in the Media browser. Single-click the icon, and the Organizer will display all content, with the content from that location highlighted. If you hover your pointer over the blue icon in each video or still image, you’ll notice that it’s been tagged to the respective places.

**Note:** In addition to the Map view, Places has a List view, which might provide better precision for certain search functions.
Tagging clips to Events

The Organizer has a Smart Events feature that you can use to find content without any tagging on your part. To see this function in action, click Events (Events), and then select Smart Events in the Events top toolbar. This shows all content grouped by date in the Media browser, which you can navigate through using the vertical scroll bar on the right. Or you can narrow your search by choosing a year, month, and/or day using the calendar.

Sometimes, however, you'll want to manually organize clips into Events—perhaps because, like our trip to New Orleans, the event took place over multiple days. Or maybe you shot video and pictures at more than one event on a particular day and need to break them into multiple events, like a wedding ceremony and wedding reception. Here, we'll manually create Events with the Adobe Organizer.

1. Click Events (Events) to enter Event view. Make sure Events is selected in the top toolbar, not Smart Events.

2. On the Organizer's bottom toolbar, click Add Event ( ). The Add New Event dialog box appears on the right.

3. Complete the information in the Add New Event dialog box:
   - In the Name field, type **Trip to New Orleans**.
   - Use the calendar controls to input a Start Date of 12/30/2012 and an End Date of 1/12/2013. It's easiest if you choose the year first and then the date.
   - In the Description field, type **New Year’s Celebration in New Orleans**.
4 Assuming that you still have Lesson04 selected in the panel on the left, all content in the Media Browser should relate to this trip. Click anywhere in the media window to select that window, and then press Ctrl+A (Windows) or Command+A (Mac OS) to select all the content in the Media browser, drag it into the window beneath the description, and release your pointer. The Organizer adds this content to the event.

5 At the bottom right of the Add New Event dialog box, click Done. The Organizer creates the event.

To find your content later on, in the Organizer’s top toolbar, click Media (Media) to exit Events view, and then click Events (Events) to return to that view. You should see the Trip to New Orleans event in the Media browser window. If you double-click it, the clips that you associated with the event will appear in the Media Browser. If you hover your pointer over the calendar icon for a particular clip in the Media browser, you’ll see the event with which it has been associated.
Working with star ratings

As mentioned earlier, star ratings allow you to manually rate your clips on a scale from 1 to 5 (left to right) and then search for clips based on those ratings.

1. Click Media to return to Media view. If you don't see the star ratings for your clips, choose View > Details from the Organizer main menu bar.

2. Hover your pointer over the star ratings beneath any clip, and click the star that corresponds to the desired rating for that clip. Go ahead and rate a few clips. These are all five-star clips as far as I’m concerned, but go ahead and rate some across the board.

3. To change a rating, use the same procedure, and choose a different rating.

4. To delete the star rating, click the last selected star on the right (e.g., the fourth star in a clip rated four stars).
5 To find clips based on their assigned ratings, click the number of target stars in the Ratings bar on the top right, and in the pull-down menu beneath the ratings, choose how to apply the rating. For example, in the figure below, we elected to show all clips with a four-star rating or higher.

![Ratings Bar Example](image)

6 To stop sorting by star rating and show all clips in the Organizer, delete the star rating on the upper right by clicking the last selected star.

### Working with keyword tags

Adobe Premiere Elements includes general categories of keyword tags that you can apply as is or customize with your own categories or subcategories. You can also supplement your entries in the People, Places, and Events tagging structure with manual keywords following this same procedure.

In this exercise, you’ll create and apply a custom keyword in the Organizer, and then search for clips based on that keyword. To ensure that you’re looking at the same content as appears in this book, make sure you’ve selected the Lesson04 folder in the My Folders section of the Albums And Folders panel on the left of the Organizer. See the first few steps of the earlier section “Tagging in the Organizer” to accomplish this.

1 On the bottom right of the Organizer, click Tags/Info (Tags/Info) to open the Tags/Information panel.

2 Below Keywords, click Other.
3 Next to Keywords, click the Create New button ( ), and choose New Sub-Category.

4 In the Create Sub-Category dialog box, type **Boat Rides** in the Sub-Category Name field. Then click OK.

Adobe Premiere Elements creates the new subcategory.

5 Click the blue tag next to Boat Rides, and drag it onto any of the videos in the Media browser. In this example, I’ve already applied the tag to Gator01.mp4 and Gator02.mp4 and am applying it to Gator03.mp4.

*Note: The screen on your computer may differ slightly from what’s shown here, but the differences shouldn’t interfere with completing the lesson.*
6 To view the clips that you’ve just tagged, click the greater than icon (>) to
the right of Boat Rides, which opens the Tagging Search window that shows
Keywords on the upper left and the clips that you just tagged in the Media
browser (you may have to click the Tags/Info toggle to expose those fields). This
window shows all tags created via keywords as well as the People, Places, and
Events that you’ve set up. You can select any options in any of these categories
or combination of categories to include content from these sources in the Media
Browser. You can even apply star ratings to further refine your search.

7 In the upper left toolbar in the Tagging Search window, click the Back button
(Back ) to close that search window.
About the Auto-Analyzer

As mentioned earlier, the Auto-Analyzer evaluates your video clips for content and quality, and is integral to a number of functions, including Smart Tagging, Smart Trimming, and creating InstantMovies (which you'll learn to do later in this lesson). You can run the Auto-Analyzer manually or run it automatically as a background process. In fact, by default, any time your system is running and idle, the Auto-Analyzer will run on clips that you import, so when you're ready to edit, you won't have to wait for the Auto-Analyzer to run.

To control the Auto-Analyzer behavior, in the Organizer, choose Edit > Preferences > Media-Analysis (Windows) or Elements Organizer > Preferences > Media Analysis (Mac OS).

In most instances on most computers, background operation should work just fine. On older, less powerful computers, and those configured with the minimum RAM, background operation may cause a noticeable drag on foreground operations, particularly when you're working with H.264-based, high-definition formats like AVCHD and video shot by DSLRs. If you notice any sluggishness in your foreground operations after importing footage or experience any system instability, try disabling the Auto-Analyzer as a background operation by deselecting Analyze Media For Smart Tags Automatically.
Running the Auto-Analyzer manually

We’ll manually run the Auto-Analyzer and apply Smart Tags to the project clips. Again, to ensure that you’re looking at the same content that appears in the book, make sure you’ve selected the Lesson04 folder in the My Folders section of the Albums And Folders panel on the left of the Organizer. See the first few steps of the earlier section “Tagging in the Organizer” to accomplish this.

1. If the Organizer isn’t open, click the Organizer icon ( ) on the Action bar. If it’s already open, press Alt+Tab (Windows) or Command+Tab to switch to the Organizer.

2. Press Ctrl+A (Windows) or Command+A (Mac OS) to select all clips, and then right-click and choose Run Auto-Analyzer. This can take a while, so you might want to try one or two clips first.

3. The Organizer starts analyzing the clips and displays a progress bar. The duration of the process will vary by clip length, clip format, and the speed of your computer. After completion, Adobe Premiere Elements will display a status message letting you know that the analysis is complete.

4. In the Organizer, if necessary, press Ctrl+D (Windows) or Command+D (Mac OS) to display file details. A purple tag beneath the clip’s thumbnail indicates that Smart Tagging has been applied; hover your pointer over the tag to see which quality-related tags were applied.
5 To remove a tag, right-click the tag in the Organizer, and choose Remove.
Repeat as necessary for other tags.

**Working with clips after Smart Tagging**

Let’s take a moment to understand what happens to clips after Smart Tagging has occurred. To review, during Smart Tagging, Adobe Premiere Elements breaks the clip into different scenes based on content changes (as opposed to timecode, like DV files); finds different types of content, such as faces; and rates the quality of each clip based on factors like exposure, focus, and stability.

In the Organizer, you’ll know that the clip has been split into multiple scenes if there is a Step Forward icon (○) to the right of the clip. Click that icon, and Adobe Premiere Elements displays all scenes separately in the Organizer, surrounded by a border that's a different shade of gray from the rest of the Organizer. This lets you know that all the scenes are part of a single clip.

You should see separate scenes in the Gator12.mp4 clip, where the Organizer separated sections where the alligator was on land and then in the water. In the Organizer, you can treat each scene as a separate clip—for example, double-clicking it to play it in the preview window. You can consolidate all scenes back into a single frame by clicking the Step Backward icon to the right of the final scene (○).
From the Organizer to Adobe Premiere Elements

After you've collected the clips you want to use in the Organizer, you have several options for transferring them to Adobe Premiere Elements:

- Send them all to Adobe Premiere Elements to start a new project or for insertion at the end of the timeline in an open project. Briefly, you select the desired clips, right-click, and choose Edit With Premiere Elements Editor. Note that you can select complete clips or segments of clips identified by the Auto-Analyzer. The full procedure is documented in “Working in the Organizer” in Lesson 1. This option works well for simple projects, because it adds all content to the timeline quickly.

- Drag the clips into the Project Assets panel. (Remember, you must be in Expert view to see the Project Assets panel.) This option gives you the most flexibility, because you can add the content to the timeline in any order and at any time.

- Create an InstantMovie from the content by selecting it in the Organizer and sending it to Adobe Premiere Elements. This is the option explored in the next exercise.

Creating an InstantMovie

In this exercise, you’ll create an InstantMovie from the bayou boatride clips that you tagged previously. Again, an InstantMovie is a professional-looking edited movie complete with titles, soundtrack, effects, and transitions that you create by following a simple wizard.

Note: You can create InstantMovies from within Adobe Premiere Elements by adding the desired clips to the timeline in either Quick or Expert view and clicking the Instant Movie button on the Action bar. From there, the procedure is virtually identical to what’s described here. When creating an InstantMovie, Adobe Premiere Elements removes all effects, transitions, and titles that you’ve added to the project, so trim the excess content from your clips, but don’t add these elements because they will all be eliminated.
You’ll start in the Organizer, using the video clips from the Lesson04 folder. Make sure these clips are the only ones present in the Media browser. In addition, close Adobe Premiere Elements to start with a clean slate in that program. Do not overwrite the file Lesson04_Start_Win.prel (Windows) or Lesson04_Start_Mac.prel (Mac OS): If you want to save your work, save it under a different name.

1. Remove audio and photos from display in the browser: Choose View > Media Types > Photos, and then choose View > Media Types > Audio to remove these media types from the Media browser.

2. Press Ctrl+A (Windows) or Command+A (Mac OS) to select all clips in the Media browser, click the Create button (Create) in the upper right corner of the Organizer, and choose InstantMovie (Instant Movie). Adobe Premiere Elements launches. If the Format Mismatch dialog box opens, click Yes to change the project preset to match the clips.

3. If a Save Project dialog box opens, name the file Lesson04_InstantMovie.prel, and save it in the Lesson04 folder.

4. If a dialog box opens asking if you want to fix problems in the clips, click No.

5. In the Choose A Movie Theme dialog box, select Extreme Sports, and click Next. (If this theme is not available, choose another theme.)

Note: The Apply To options become active only when you apply a theme to clips already inserted into the timeline, not when you create an InstantMovie from the Organizer.
6 Customize the theme as desired. Accept the options as is, or do any or all of the following:

- Customize the opening and closing titles.
- Select the Auto Edit option to have Adobe Premiere Elements analyze your clips and edit them to fit the selected theme. It's recommended you do this; if you don't select Auto Edit, Adobe Premiere Elements uses the clips as is. Also, choose whether or not to apply the Auto-Analyzer to clips that you haven't previously analyzed.
• Click the triangle next to Music to show the Music options. There, select Theme Music to use the background music from the chosen theme, or select No Music. To use your own background music, click My Music, and then click the Browse button to choose the song you want. Then drag the Music/Sound FX slider to the desired setting—to the right to prioritize audio captured with the video clips and to the left to prioritize the selected background music. If you have dialogue in your project that you want to retain (which these clips don't), select the SmartMix option; Adobe Premiere Elements will reduce the volume of the music track when it detects dialogue.

• Click the triangle next to Speed And Intensity to show the Speed And Intensity options. Adjust the Effects and Cuts sliders as desired.

• Click the triangle next to Duration and then choose the desired option. Match Music produces a movie that matches the duration of the selected music and is recommended. Or, you can specify a duration or choose Use All Clips, which uses all clips at their original duration with no background music.

• Click the triangle next to Sequence to show the Sequence options. Choose Theme Order (recommended), which allows Adobe Premiere Elements to use clips as they best match the theme, or Time/Date, which uses the clips in the order in which they were shot.

• Click the triangle next to Theme Content to show the Theme Content options. Choose the content to incorporate into the InstantMovie and whether to replace any existing content with theme-based content. If a content type is grayed out (like the Intro/Closing Movie for the Pan and Zoom theme), it is not included in that theme.

• Click the triangle next to Render Preview, and then click Yes to render a preview of the InstantMovie after completion or No to preview it in real time from the Timeline (recommended).

7 After selecting your options, click Apply to create the InstantMovie and then do the following:

• Click No if asked if you want to select more clips.

• Click Yes if asked whether you want to replace user-applied effects.

• Click No when Adobe Premiere Elements asks if you want to render the movie.

Adobe Premiere Elements creates the InstantMovie and inserts it into the timeline in consolidated form.
8 To separate the InstantMovie into its components to edit them, click to select the new InstantMovie in the timeline, right-click, and choose Break Apart InstantMovie.

9 Use the playback controls in the Monitor panel to preview the InstantMovie. If Adobe Premiere Elements asks if you'd like to render effects before playing the movie, click Yes if you'd like to see a perfect rendition, although this may take a good bit of time, depending on your system. Click No if you have a fast system and/or just want to get a quick idea of how the movie looks.

A. Preview area
B. Add Marker
C. Current time
D. Go to Previous Edit Point (Page Up)
E. Rewind
F. Step Back (left)
G. Play/Pause toggle (spacebar)
H. Step Forward (right)
I. Fast-Forward
J. Go to Next Edit Point (Page Down)
K. Render Timeline
L. Fit to Visible Timeline (\)
M. Zoom Out (−)
N. Zoom control
O. Zoom In (=)
Review questions

1. What view must you be in to see the Project Assets panel?
2. What’s the difference between the Organizer that ships with Adobe Premiere Elements and the Organizer that ships with Adobe Photoshop Elements?
3. What are the three main content categories in the Organizer?
4. What is Smart Tagging? Are there any situations in which you wouldn’t want to apply Smart Tagging?
5. After creating an InstantMovie, how do you break up the movie to edit it further?

Review answers

1. You must be in Expert view. The Project Assets panel does not appear in Quick view.
2. This is a trick question; there is no difference. If you have Adobe Premiere Elements and Adobe Photoshop Elements installed, both programs can insert content into the same shared database and sort through and retrieve data from that database.
3. The main content categories in the Organizer are People, Places, and Events.
4. When you apply Smart Tagging to a clip, Adobe Premiere Elements analyzes the clip to detect scenes based on content; searches for specific content types, like faces; and ranks the quality of your clips. Other than processing time, there’s very little downside to applying Smart Tagging. Your video clips will be divided into useful scenes, and you can find high-quality clips much faster than you could manually.
5. Click the clip with your pointer to select it, and then right-click and choose Break Apart InstantMovie.
INDEX

NUMBERS

4:3 aspect ratio, 37
4:3 video, 37
4-pin connectors, 53–54
6-pin connectors, 53–54
9-pin connectors, 54
16:9 aspect ratio, 37
1080i video, 37
1080p video, 37

A

Action bar, 12, 18–20
action-safe margins, 206
Add Media button, 13
Add Media controls, 106
Add Media panel
  for capturing/importing video, 46–50, 60
  overview, 13–14
Add To Timeline option, 51
Adjust panel, 12, 42, 123, 124
adjustment layers, 24, 169–170
Adjustments panel, 17–18, 20, 225
Adobe Flash Video, 288
Adobe Premiere Elements
  introduction to, 6–25
  launching, 9, 28
  loading projects in, 29–30
  new features, 23–24
  video production integration, 8
Adobe Revel, 24
After Copying Delete Originals option, 51
Alt/Option key approach, 118
analog camcorders, 10, 52, 57
analog video, 52, 68
Anchor To In Point option, 165
Anchor To Out Point option, 165
animation
  buttons, 265–267
  effects via keyframes, 156–159
  text, 211
  thumbnails, 265–266
  titles, 211, 217–219
Anti-Aliasing Quality option, 189
Applied Effects panel
  adjusting keyframes, 162
  adjusting size, 42
  animating effects with keyframes, 156–159
  overview, 17–18
  working with effects, 125
Apply To options, 85
Arrange commands, 214
Arrow keys, 95
Artistic effects, 127
aspect ratio, 36–37, 286
audio, 222–240
  adding narration, 227–228
  adding to menus, 264–265
  adjusting via key frames, 231, 235–236
  adjusting volume, 230–233
  adjusting volume in Expert view, 225, 226
  adjusting volume in Quick view, 225–226
Audio Mixer, 21, 237–238
Beat Detect tool, 239–240
capturing, 52
clipping, 232
dialogue, 87
distortion, 232, 233
fading in/out, 236
gain adjustment, 230, 231, 232–233
audio (continued)
music. See music
normalization, 231, 232–233
previewing, 227
scores, 24
Smart Mix, 231, 234–236
transitions, 191, 192
waveforms, 106, 228–230, 232
Audio button, 226
audio channels, 125
audio clips, 19
audio codecs, 286
Audio controls, 286
audio effects, 19, 239–240
Audio format, 289
audio keyframes, 235
audio library, 18, 19
Audio Mixer, 21, 237–238
audio synchronization, 118
audio tracks, 93, 106, 229
Audio Transition Default Duration setting, 38
audio/video links, 118
Audio/Video tracks, 93
Auto Save files, 40
Auto Save option, 40
Auto Save preferences, 39
Auto Smart Tone effect, 129, 130–137
Auto-Analyzer, 11, 72, 81–83
auto-play discs, 250–251
AV DV converters, 52
AVCHD discs, 246, 247, 274–276
AVCHD format, 246, 288
AVCHD video, 81, 288
AVCHD/DVD camcorders
capturing video from, 10, 33, 47, 48–52
settings, 30–38
AVI codecs, 288
AVI files, 288
AVI format, 288

B
background audio tracks, 93
background music, 24, 87, 226–227, 237
backgrounds
black, 68
color, 68, 213
menus, 264
titles, 211–214
BD-R format, 247
BD-RE format, 247
BD-ROM drives, 246
BD-ROM format, 246
Beat Detect tool, 238–239
beat detection, 238–239
Bitrate Settings, 286
black adjustment, 133
black video, 68
Blu-ray Discs, 246–248, 274–276
BMP files, 292
bonus clips, 259–262
book updates, 6
borders, transition, 188–189
brightness, adjusting, 133–134
Browser pane, 10, 11
Build In Progress screen, 272
Burn button, 275
Burn To menu, 274
Burner Location menu, 275
burning discs, 274–276
buttons, 265–271
adding, 262
animating, 265–267
changing text properties, 268–271
labels, 257–259
location, 266–267
names, 258
navigational, 269
overlapping, 267
size, 266–267
C

 cache size, 40
camcorders. See also specific camcorders
    analog, 10, 52, 57
device control, 57–59
importing from, AVCHD/DVD, 10, 33, 47, 48–52
importing from, DV/HDV, 10, 33, 48, 53–59
cameras. See digital cameras
Capture button, 59
Capture panel, 48, 57–59
Capture To Timeline option, 56
capturing audio, 52
capturing/importing video, 4–61.
    See also sharing video
    Add Media panel for, 13–14, 46–50, 60
    from camcorder, AVCHD/DVD, 10, 33, 47, 48–52
    from camcorder, DV/HDV, 10, 33, 48, 53–59
capture options, 55–56
Capture panel for, 48, 57–59
clip-based imports, 33, 47–48, 57–59
connecting devices for, 53–55
converting analog to digital, 52
    with device control, 57–59
    from DSLR cameras, 10, 33, 47, 48–52
    in Expert view, 13, 14, 55–56
    from hard drive, 47, 60
interfaces for, 47–48
live video, 47–48, 53–57
    from optical media, 10, 33, 47, 48–52
overview, 46
    in Quick view, 13–14, 55–56
scene detection, 56
    from SD cards, 10, 33, 47, 48–52
    from smartphones, 10, 33, 47, 48–52
stop-motion video, 51
system setup, 55
tape-based video, 47–48, 53–57
timecode and, 56
time-lapse video, 51
    with Video Importer, 47, 48–52
Cartoonr Plus effect, 127
CD-R drives, 246
Change Settings dialog box, 34–35
Channel Volume, 125
Choose A Movie Theme dialog box, 85–87
Clean Now button, 40
Clip Gain dialog box, 232
Clip Volume adjustment, 225
clip-based capture, 33, 47–48, 57–59
clipping, 232
clips
    adding in Expert view, 106–107
    adding in Quick view, 97–98
    adding to menus, 263–265
    analyzing with Auto-Analyzer, 81–83
    bonus, 259–262
    capturing. See capturing/importing video
    composited, 172–174
    deleting in Expert view, 109
    deleting in Quick view, 100
dragging/dropping, 97–98
editing. See video editing
effects. See effects
importing. See capturing/importing video
information about, 22
mismatched, 85
moving in Expert view, 108–109
moving in Quick view, 98–100
organizing. See Organizer
outtakes, 259–262
perfecting with effects, 129–130
selecting multiple adjacent, 108
sequence, 87
splitting in Quick view, 103–104
star ratings, 77–78
tagging. See tagging clips
themes. See themes
thumbnails, 106
time-remapping, 141, 142–145
trimming in Expert view, 110–112
trimming in Quick view, 100–102
viewing filename, 98
viewing info about, 98
codecs, 285, 286, 288–289
color
  backgrounds, 68, 213
  borders, 188–189
  HSB, 189
  HSL, 189
  RGB, 136–137, 189, 270
  saturation, 135–136
  text, 207–208, 270
  transitions, 188–189
  YUV, 271–273
Color effect, 129, 135–136
Color (RGB) effect, 129, 136–137
color effects, 129, 135–137
color mattes, 68
Color Picker, 189, 270
Color Properties dialog box, 207–208, 213
color slider, 189
color-value sets, 189
composite images, 126
compositing, 172–174
compression, 274
Computer option, 21
computer screens, 206
Constant Gain transition, 192
Constant Power transition, 192
content, 62–88
  adding to menus, 263–265
  finding, 66
  importing from hard drives, 47, 60
  organizing into folders, 67
  reframing with Motion controls, 146–149
  theme-based, 87
content-based scene detection, 56
contrast, 133–134
Copy option, 109
crawls, 217
Create option, 11
Create SlideShow dialog box, 114–115
cross-dissolve transitions, 191
CTI (current-time indicator), 32, 68, 93, 96
Curative effects, 126
current-time indicator (CTI), 32, 68, 93, 96
Custom Name-Number option, 51
Cut option, 100, 109
cuts, 181
data transfer rates, 55
Date-File Name option, 51
Delete And Close Gap option, 100, 108, 109
Delete Audio option, 100, 109
Delete option, 109
Delete Video option, 109
Details option, 71
device control, 57–59
dialogue, 87
digital cameras
  capturing/importing video from, 10, 33, 47, 48–52
  considerations, 8, 10
digital signals, outputting, 52
digital video. See DV
Dip To Black transition, 190
Disc Layout workspace, 263
Disc option, 21
discs
  adding menus to. See menus
  auto-play, 250–251
  AVCHD, 246, 247, 274–276
  Blu-ray, 246–248, 274–276
  burning, 274–276
  DVDs. See DVDs
  markers. See scene markers
  naming, 275
  overview, 246–248
  recordable, 247
Dissolve folder, 190, 191
dissolves, 191
drop zones, 263
DSLR cameras. See digital cameras
Dual Monitor Workspace option, 42
Duration option, 87
DV (digital video), 32–34, 52
DV camcorders. See AVCHD/DVD camcorders
DV files, 32
DVD discs, 274–276
DVD player, 246
DVD-R DL discs, 247
DVD+R DL discs, 247
DVD-R drives, 246
DVD-R format, 247
DVD+R format, 247
DVD-ROM, 246
DVD-RW format, 247
DVD+RW format, 247
DVDs. See also discs
  adding menus to. See menus
capturing/importing video from, 10, 33, 47, 48–52
described, 246
web, 247, 271–273
DVD-Video format, 246

E

Earthquake effect, 127
Ease-In option, 218
Ease-Out option, 218
editing. See video editing
Editing modes, 92
Effect controls, 159
effects, 120–275
  adjustment layers, 169–170
  animating, 156–159
  Applied Effects panel, 125
  applying to multiple clips, 163–170
  Artistic, 127
  audio, 19, 239–240
  Auto Smart Tone, 130–137
color, 129, 135–137
copying/pasting, 163, 164–165, 166
curative, 126
deleting, 159
Effects panel, 126
Entire Movie button, 167–168
fading in/out, 209–210
FilmLooks, 127, 168–170
Gamma Correction, 129, 130, 134–135
keyframes. See keyframes
Lighting Effects, 133–134
motion, 125, 127, 144–149
Motion controls, 146–149
Motion Tracking for, 174–176
Opacity, 160–162
overlay, 126
Pan & Zoom, 126, 151–155
perfecting clips with, 129–130
Picture-in-Picture overlays, 170–172
previewing, 139
rendering, 139–141
resetting to defaults, 159
sharing, 163, 164–168
slow-motion, 144–145
Smart Fix, 127–129
sound, 239–240
Speed controls, 127
Stabilizer, 137–138
text animation, 211
Time Remapping, 141–145
Time Stretch, 149
toggling on/off, 129, 159
Tools panel, 125
using, 123–127
variable-speed, 144–145
video, 19
Videomerge for, 172–174
Vignetting, 156–159
workflows, 126–127
effects library, 18, 19
Effects panel, 123, 126
End key, 96
End Off Screen option, 218
Entire Movie button, 167–168
eSATA technology, 55
events, tagging clips to, 75–77
Expert button, 13
Expert view
  adding clips in, 106–107
  adding/deleting tracks, 105
  adjusting volume in, 225, 226
  changing track height, 105
  components, 41
  considerations, 13
  creating slide shows in, 113–115
customizing track views, 106
deleting clips in, 109
effects, 19–20, 126
importing in, 13, 14
moving clips in, 108–109
Expert view (continued)
   overview, 8
   vs. Quick view, 106
   Smart Trim mode, 115–118
   Split Clip tool, 112–115
   trimming clips in, 110–112
   video editing in, 104–106
   working with transitions in, 184–186
Expert view timeline, 14, 15
Expert view toggle, 12
Export Frame dialog box, 292
Export Settings dialog box, 285–286
exporting video. See also capturing/
   importing video
   frames as still images, 291–292
   output formats, 284–289
   projects as standalone video, 284–289
   Publish+Share options, 280
   to smartphones/players, 289–290

F
F4V files, 288
Facebook, 281
fade-ins/fade-outs
   applying to title clips, 209–210
   audio, 236
   creating via keyframes, 159–163
   creating via transitions, 190
   volume adjustments, 234
File Name option, 51, 71
filenames, 30, 51, 98
files
   Auto Save, 40
   AVI, 288
   BMP, 292
   DV, 32
   F4V, 288
   FLV, 288
   location, 50
   original, 32
   video, 9–10, 32, 50
FilmLooks feature, 126, 168–170
FilmLooks folder, 127
Fit To Visible Timeline button, 95, 98, 107
Fit To Visible Timeline icon, 101
Flash Video For YouTube preset, 282
Flip4Mac, 289
FLV files, 288
Folder Name-Number option, 51
folders, 39, 50, 67
fonts, 255, 268–269, 270
Format Mismatch dialog box, 85
fps (frames per second), 38, 97
fragmentation, 55
frame rate, 30, 38
frames
   locating specific, 94
   moving to specific points in, 95–96
   repeated, 193–194
   trimmed, 194
frames per second (fps), 38, 97
Freeze Frame dialog box, 291
Freeze Frame tool, 20
FTP access, 273
FTP utility, 273

G
gain adjustment, 230, 231, 232–233
Gamma Correction, 129, 130, 134–135
gaps, 108, 109
General Preferences panel, 38–39
Get Media button, 10, 50, 51
Get Photos And Videos option, 9–10
Go to Next Edit Point button, 95
Go to Previous Edit Point button, 95
Google Maps, 72–74
Gradient menu, 207–208
graphics elements, 19, 215–217
graphics library, 18, 19
Guided button, 13, 92
guided edits, 92
Guided view, 15–16
Guided view toggle, 12
H

H.264 codec, 285, 289
hard drives
  considerations, 10, 33, 55, 59
  fragmentation, 55
importing content from, 47, 60
loading video files from, 9
sharing/exporting video, 280–281
sufficient space on, 55
transferring media to, 51, 55
HD mode, 271–272
HD (high-definition) video, 127
HDV camcorders
  capturing/importing video from, 10, 33, 48, 53–59
  connectors on, 54–55
  setting up, 55
High Definition Video For YouTube preset, 282
high-definition. See HD
History panel, 22
Home key, 96
Horizontal type tool, 202–203, 207
HSB (Hue, Saturation, and Brightness), 189
HSL (Hue, Saturation, and Lightness), 189
Hue, Saturation, and Brightness (HSB), 189
Hue, Saturation, and Lightness (HSL), 189

I

IEEE 1394 ports, 53–54, 55
IEEE 1394 standard, 53–54
Image format, 289
images
  adding to titles, 208–209
  composite, 126
  graphics elements, 19, 215–217
  graphics library, 18, 19
  reframing with Motion controls, 148–149
  slide shows, 113–115
  still. See still images
importing video. See capturing/importing video
In points. See also Out points
  adjusting, 100, 110
  anchoring to, 165
  described, 100
  setting in Preview window, 68, 69, 70
  for thumbnail videos, 264, 266
Information panel, 22
Insert In Movie option, 291
Instant Movie panel, 18
InstantMovies, 51, 84–88
“Insufficient media” error message, 193–194
Interest Level slider, 116–117
interlaced video, 37
iPad, exporting video to, 289–290

J

J-cuts, 118

K

keyframes, 156–162
  adjusting, 162–163
  adjusting volume with, 231, 235–236
  animating effects with, 18, 156–159
  audio, 235
  considerations, 157
  creating fade-outs with, 159–163
  deleting, 162
  described, 156, 235
  modifying, 162–163
  presets, 164, 165–166
  scaling, 165
  showing/hiding, 156
keyframing, 156
keyword tagging, 72, 78–80
keywords, 78–80

L

laptop computers, 54
layering, 104
layers, adjustment, 24, 169–170
L-cuts, 118
letterboxing, 31, 34
libraries, 18, 19
lighting adjustments, 133–134
lighting effects, 130, 133–134
Lightning Effects, 127
linked video, 118
live video capture
  vs. clip-based import, 47–48
  procedure for, 47–48, 53–57

M
main menu markers, 262
margins, 206
marker buttons, 268
Maximum Project Versions setting, 39
media
  cache, 39, 40
  capturing. See capturing/importing video
  not found, 244
  optical. See optical media
  preferences, 40
  sorting, 11
  specifying location for, 51
  types of, 71
Media Not Found error message, 244
Media Types option, 71
Menu Background options, 264
Menu Marker dialog box, 248–249, 258
menu markers, 262
Menu Theme panel, 251–253
menu titles, 268
menus, 242–276
  adding audio, 264–265
  adding visual content, 263–265
  backgrounds, 264
  bonus clips, 259–262
  creating, 253–256
  customizing, 263–265
  getting started, 244–246
  looping, 264
  submenus, 259–262
  templates, 253–254, 257
microphones, 52
midtone adjustment, 134–135
Missing Disc Menu dialog box, 250
Mobile Phones and Players option, 21
Monitor panel
  adjusting size, 41, 42
  centering elements in, 205
  overview, 12–13, 16
  playing movies in, 94
  video editing in, 93–97
  zooming in/out, 95
monitors, dual, 42
Motion controls, 146–149
motion effects, 125, 127, 144–145
motion menu buttons, 266
motion tracking, 21, 23, 125, 174–176
MOV format, 287
Movie Menu tool, 20
movies. See also video
  Entire Movie button, 167–168
  InstantMovies, 51, 84–88
  moving to specific points in, 95–96
  playing. See playback
  positioning CTI at beginning/end of, 96
  sharing. See exporting video
  themes. See themes
  YouTube, 281–284
MPEG format, 288
music
  background, 24, 87, 226–227, 237
  beat detection, 238–239
  themes, 87
Music option, 87
musical soundtracks, 226–227

N
Name option, 71
narration, adding, 227–228
Narration tool, 21
Narration track, 93
navigation, 259
navigational buttons, 268, 269
New Project command, 33, 34
New Project dialog box, 29
Next Scene control, 57
Normalization option, 231, 232–233
notebook computers, 54
NTSC DV 16:9 preset, 285
NTSC settings, 271–272
NTSC sources, 36
NTSC video, 56, 97, 275, 276

O

objects
  - modifying text attributes, 268
  - moving, 51, 174–176
  - tracking, 21, 23, 125
On Start Always Launch option, 28
Opacity effect, 160–162
Opacity panel, 213
Open Project dialog box, 30
optical media
  - capturing video from, 10, 33, 47, 48–52
  - recording, 247
Options menu, 28
Organizer, 70–88
  - Auto-Analyzer function, 81–83
  - displaying all clips in Timeline view, 72
  - Keyword Tags in, 78–80
  - launching, 9
  - loading video files in, 9–10
  - organizing clips in, 72–80
  - overview, 9, 11–13, 70–72
  - playing videos in, 71
  - selecting videos, 11
  - sorting media, 11
  - star ratings in, 77–78
  - tagging clips to Events, 75–77
  - tagging clips to Places, 72–74
  - transferring clips from, 84
  - viewing still images in, 71
  - working in, 11–22
Out points. See also In points
  - adjusting, 100, 110
  - anchoring to, 165
  - considerations, 265
  - described, 100
  - setting in Preview window, 68, 69, 70
outtake clips, 259–262
Overlay effects, 126
overlay titles, 200, 201, 211–214
overscan, 206

P

Page Down key, 95
Page Up key, 95
PAL video, 56, 97, 275, 276
Pan & Zoom effect, 126, 151–155
Pan & Zoom tool, 21, 125
Paste Effects And Adjustments option, 109
Pause button, 59, 94
PC cards, 55
PCI cards, 55
photos. See images
physical media, 247–248
Picture-in-Picture (PiP) overlays, 170–172
PiP (Picture-in-Picture) overlays, 170–172
pixel aspect ratio, 36–37
places, tagging clips to, 72–74
play buttons, 94, 268
playback
  - in Audio Mixer, 238
  - changing speed of, 149
  - by double-clicking file, 287
  - in Monitor panel, 94
  - in Organizer, 71
  - pausing, 94
  - in QuickTime Player, 287
  - stopping, 262
  - web DVDs, 273
playhead, 93
Postroll option, 218
preferences
  - Auto Save, 39
  - general, 38–39
  - media, 40
  - projects, 38–40
  - ScratchDisks, 39
  - startup, 28
.prel extension, 30
Premiere Elements
  - introduction to, 6–25
  - launching, 9, 28
  - loading projects in, 29–30
  - new features, 23–24
  - video production integration, 8
Premiere Elements Auto-Save folder, 40
Preroll option, 218
presets
details about, 35
forcing use of, 35
project-settings, 29–38
resolution, 36–37
saving, 164, 165–166
social websites, 281–282
sources, 36
video output formats, 284–289
web DVDs, 271
Preview Disc window, 245, 252–253, 258–259
Preview window, 68–70
previews
audio, 227
considerations, 96
display rate of, 96
effects, 139
InstantMovies, 88
from Project Assets panel, 68–70
rendering, 87, 96
skipping, 174
transitions, 181, 183, 188
video files, 50
Previous Scene control, 57
Private Web Gallery option, 21
progressive video, 37
Project Assets folder, 107
Project Assets panel, 169–170
controls in, 66–70
dragging clips into, 84
finding content in, 14
loading files in, 65
viewing files in, 66
working in, 65–70
Project command, 33, 34
project folders, 39
Project panel, 14
Project Settings dialog box, 32
projects
loading, 29–30
location, 35
naming, 35
opening, 29–30
preferences, 38–40
saving, 35
setting up, 29–38
starting, 11
starting new, 33
project-settings preset, 29–38
Publish+Share options, 280
Publish+Share panel, 12, 21, 280

Q
Quality Level slider, 116–117
Quick button, 12, 13
Quick view
adding clips in, 97–98
components, 41
considerations, 13, 14
deleting clips in, 100
effects, 19–20, 126
vs. Expert view, 106
importing in, 13–14
moving clips in, 99–100
overview, 8
Split Clip tool, 103–104
tracks, 93
trimming clips in, 100–102
video editing in, 97–102
working with transitions in, 182–183
Quick view timeline, 12, 14–15
Quick view toggle, 12
QuickTime, 288, 289
QuickTime Player, 287

R
ratings, star, 72, 77–78
rearrange pointer, 108
Recorder Error message, 59
Red, Green, and Blue. See RGB
Redo command, 22
Render At Maximum Depth option, 286
render bar, 34
Render button, 96, 183, 185
Render Preview option, 87
rendering
  effects, 139–141
  footage, 31
  previews, 87, 96
  time required for, 272
  transitions, 183, 185
  video, 31, 286
Replace Clip From Project Assets option, 109
Reset icon, 159
resolution, 30, 36–37, 276
Restore Workspace option, 30, 42
Revel, 24
rewritable discs, 247
RGB (Red, Green, and Blue), 189
RGB color, 136–137, 270
RGB values, 208
ripple deletion, 100, 109
Roll/Crawl Options, 218
rolling credits, 217–219
rollover effects, 256

S
  safe zones, 206, 255
  saturation, 135–136
  Scale option, 165
  scene detection, 56
Scene Marker buttons, 257–259, 268
scene markers
  automatically generating, 251–253
  described, 262
  manually adding, 248–249
Scene Selection menu, 254
Scenes button, 262
scissors icon, 103, 113
scores, 24, 226–227
ScratchDisks preferences, 39
scrubbing through videos, 94
SD card readers, 49
SD cards, 10, 33, 47, 48–52
SD mode, 271–272
SD (standard definition) video, 127
Send To Back command, 214
Sequence option, 87
Set Audio Track Display Style button, 106
Set Video Track Display Style button, 106
Shadow/Highlight effect, 127–129
Shapes tab, 213
Share WorkArea Bar Only option, 282, 287
sharing video. See also capturing/importing
  video
effects, 163, 164–168
  options for, 21
  Publish+Share panel, 12, 21
Show Safe Margins, 255, 267
Shuttle control, 57
Skip Previews button, 174
slide shows, creating, 113–115
slow-motion effects, 144–145
Smart Events, 75–77
Smart Fix, 127–129
Smart Mix tool, 21, 231, 234–236
Smart Mixer, 234–236
Smart Tagging, 72, 83
Smart Tags, 11, 81–83
Smart Trim mode, 115–118
Smart Trim Options, 116
Smart Trim tool, 21
SmartMix option, 87
smartphones
  capturing video from, 10, 33, 47, 48–52
  exporting video to, 289–290
snapshot export function, 292
Social Website presets, 281–282
Social Websites option, 21
sorting media, 11
sound. See audio
sound cards, 52
source presets, 36
speech bubbles, 200, 215–217
Speed And Intensity option, 87
Speed controls, 127
Split Clip tool, 103–104, 112–115
split edits, 118
Stabilizer effect, 137–138
standard definition. See SD
star ratings, 72, 77–78
Start Off Screen option, 218
startup preferences, 28
Step Back button, 95
Step Forward button, 95
Still Image Default Duration setting, 38
still images
adding to menus, 263–265
duration of, 200, 201
exporting video frames as, 291–292
viewing in Organizer, 71
stop markers, 259–260, 262
stop-motion video, 51
stopwatch icon, 157, 159
storyboard-style editing, 97
streaming playback, 187
submenus, 259–262
Summer Day FilmLook, 169, 170

T
tagging clips
to Events, 75–77
Organizer techniques for, 70–72
to Places, 72–74
removing tags, 83
tags, 11
Tags/Info icon, 11
Tags/Information panel, 11
tape-based video capture, 10, 33, 48, 53–59
Temperature and Tint effect, 130
templates
menus, 253–254, 257
titles, 19, 200, 202
text. See also titles
animating, 211
centering, 205
changing alignment/style/size, 204–205
color, 207–208, 270
gradient, 207–208
overview, 199–201
scaling, 267
size, 268–269
Speech Bubbles, 215–217
text library, 18, 19
Text track, 201
Theme Content option, 87
Theme Music option, 87
themes
choosing, 85–86
fitting clips to, 86
music, 87
titles, 200
thumbnails
animating, 265–266
scene markers, 257–259
Time Remapping effect, 21, 125, 141–145
Time Stretch effect, 21, 149
timecode, 56, 97
timecode format, 56
timecode numbers, 56
timecode-based scene detection, 56, 57
time-lapse video, 51
timeline panel, 13, 41
title Safe area, 255
title track, 93
titles. See also text
adding images to, 208–209
animated, 211, 217–219
backgrounds, 211–214
centering, 205
considerations, 257
crawls, 217
creating, 201, 202–203
customizing, 255–256
duration of, 200, 209, 214
delay, 201
fade-in/fade-out, 209–210
full-screen, 200, 202–203
modifying text in, 203–205
overlay, 200, 201, 211–214
overview, 199–201
rolling credits, 217–219
safe zones, 255
Speech Bubbles, 215–217
superimposing over video clips, 211–214
templates, 200, 202
text alignment/style/size, 204–205
themes, 200
using graphics with, 215–217
titles library, 18, 19
<table>
<thead>
<tr>
<th><strong>Titles &amp; Text panel, 199–203</strong></th>
<th><strong>Tools button, 238</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>title-safe margins, 206</td>
<td></td>
</tr>
<tr>
<td>title-safe zone, 267</td>
<td></td>
</tr>
<tr>
<td>Tools panel, 20–21, 125, 238</td>
<td></td>
</tr>
<tr>
<td>tracks</td>
<td></td>
</tr>
<tr>
<td>adding/deleting, 105</td>
<td></td>
</tr>
<tr>
<td>audio, 93, 106, 229</td>
<td></td>
</tr>
<tr>
<td>Audio/Video, 93</td>
<td></td>
</tr>
<tr>
<td>Background audio, 93</td>
<td></td>
</tr>
<tr>
<td>changing height of, 105</td>
<td></td>
</tr>
<tr>
<td>customizing views, 106</td>
<td></td>
</tr>
<tr>
<td>described, 105</td>
<td></td>
</tr>
<tr>
<td>empty, 105</td>
<td></td>
</tr>
<tr>
<td>Narration, 93</td>
<td></td>
</tr>
<tr>
<td>Quick view, 93</td>
<td></td>
</tr>
<tr>
<td>stacking order, 105</td>
<td></td>
</tr>
<tr>
<td>Title, 93</td>
<td></td>
</tr>
<tr>
<td>Transition Adjustments dialog box, 183, 184–189</td>
<td></td>
</tr>
<tr>
<td>transitions, 178–194</td>
<td></td>
</tr>
<tr>
<td>adjust start/end points of, 188</td>
<td></td>
</tr>
<tr>
<td>alignment, 187</td>
<td></td>
</tr>
<tr>
<td>applying to multiple clips, 191–192</td>
<td></td>
</tr>
<tr>
<td>audio, 191, 192</td>
<td></td>
</tr>
<tr>
<td>borders, 188–189</td>
<td></td>
</tr>
<tr>
<td>color, 188–189</td>
<td></td>
</tr>
<tr>
<td>copying/pasting, 186</td>
<td></td>
</tr>
<tr>
<td>cuts, 181</td>
<td></td>
</tr>
<tr>
<td>deleted clips and, 100</td>
<td></td>
</tr>
<tr>
<td>deleting, 183, 186</td>
<td></td>
</tr>
<tr>
<td>described, 181</td>
<td></td>
</tr>
<tr>
<td>duration of, 183, 186, 187, 190</td>
<td></td>
</tr>
<tr>
<td>in Expert view, 184–186</td>
<td></td>
</tr>
<tr>
<td>fade-ins/fade-outs, 190</td>
<td></td>
</tr>
<tr>
<td>“Insufficient media” issues, 193–194</td>
<td></td>
</tr>
<tr>
<td>previewing, 181, 183, 188</td>
<td></td>
</tr>
<tr>
<td>properties, 186–189</td>
<td></td>
</tr>
<tr>
<td>in Quick view, 182–183</td>
<td></td>
</tr>
<tr>
<td>rendering, 183, 185</td>
<td></td>
</tr>
<tr>
<td>“repeated frames,” 193–194</td>
<td></td>
</tr>
<tr>
<td>replacing, 183, 185</td>
<td></td>
</tr>
<tr>
<td>reversing, 189</td>
<td></td>
</tr>
<tr>
<td>searching for, 181</td>
<td></td>
</tr>
<tr>
<td>single-sided, 190</td>
<td></td>
</tr>
<tr>
<td>slide shows, 115</td>
<td></td>
</tr>
<tr>
<td>streaming playback, 187</td>
<td></td>
</tr>
<tr>
<td>tips for, 192–193</td>
<td></td>
</tr>
<tr>
<td>viewing types of, 181–182</td>
<td></td>
</tr>
<tr>
<td>working with, 181–194</td>
<td></td>
</tr>
<tr>
<td>Transitions button, 181</td>
<td></td>
</tr>
<tr>
<td>transitions library, 18, 19</td>
<td></td>
</tr>
<tr>
<td>Transitions panel, 181, 182, 184</td>
<td></td>
</tr>
<tr>
<td>trash can icon, 159</td>
<td></td>
</tr>
<tr>
<td>trim icon, 101</td>
<td></td>
</tr>
<tr>
<td>Trim view</td>
<td></td>
</tr>
<tr>
<td>Expert view, 110–112</td>
<td></td>
</tr>
<tr>
<td>Quick view, 100–102</td>
<td></td>
</tr>
<tr>
<td>trimmed frames, 194</td>
<td></td>
</tr>
<tr>
<td>trimming clips, 110–112</td>
<td></td>
</tr>
<tr>
<td>type. See text</td>
<td></td>
</tr>
<tr>
<td>Type option, 165</td>
<td></td>
</tr>
</tbody>
</table>

**U**

| Undo feature, 22, 99          |               |
| Universal Counting Leader, 68 |               |
| universal toggle animation button, 158 |           |
| Unlink Audio and Video option, 118 |         |
| updates, book, 6              |               |
| USB 2.0 ports, 54, 55         |               |
| USB drive, 274                |               |
| USB port, 274                 |               |
| USB protocol, 54              |               |
| Use Still Frame, 264          |               |

**V**

| variable-speed effects, 144–145 |               |
| video. See also movies          |               |
| analog, 52, 68                  |               |
| AVCHD, 81, 288                  |               |
| AVI, 288                        |               |
| black, 68                       |               |
| capturing. See capturing/importing video |           |
| compressing, 274                |               |
| digital, 52                     |               |
| effects. See effects            |               |
| exporting. See exporting video  |               |
video (continued)
finding, 66
Flash, 282
importing. See capturing/importing video
InstantMovies, 51, 84–88
interlaced, 37
letterboxing, 31, 34
linked, 118
live, 47–48, 53–57
moving to specific points in, 95–96
MPEG, 288
NTSC, 56, 97, 275, 276
organizing into folders, 67
PAL, 56, 97, 275, 276
playback. See playback
playing in Organizer, 71
progressive, 37
reframing with Motion controls, 146–148
rendering. See rendering
scrubbing through, 94
selecting, 11
sharing. See sharing video
slide shows, 113–115
stabilizing, 137–138
stop-motion, 51
tagging. See tagging clips
tape-based, 47–48, 53–57
themes. See themes
time-lapse, 51
XAVC, 288
YouTube, 281–284
video capture. See capturing/importing video
Video Codec menu, 285
video decks, 57
video editing, 90–118
adding clips in Expert view, 105, 106–107
adding clips in Quick view, 97–98
basic, 8
changing track height, 105
creating slide shows, 113–115
customizing track views, 106
cuts, 181
deleting clips in Expert view, 105, 109
deleting clips in Quick view, 100
dragging/dropping clips, 97–98
in Expert view, 14, 15, 104–106
in Guided view, 15–16, 92
J-cuts, 118
layering, 104
L-cuts, 118
in Monitor panel, 93–97
moving clips in Expert view, 108–109
moving clips in Quick view, 99–100
nondestructive edits, 68
in Quick view, 14–15, 97–102
ripple deletion, 100
scrubbing through videos, 94
Smart Trim mode, 115–118
Split Clip tool, Expert view, 112–115
Split Clip tool, Quick view, 103–104
split edits, 118
storyboard-style, 97
trimming clips in Expert view, 110–112
trimming clips in Quick view, 100–102
undo feature, 22
Video Editor, 11–13
interface, 12
opening, 11–12
opening projects, 30
video effects, 19
video files, 9–10, 32, 50
Video Importer, 47, 48–52
video producers, 8
video tracks. See tracks
Video Transition Default Duration setting, 38
video/audio links, 118
Videomerge effect, 172–174
Vignetting effect, 156–159
Vimeo, 281
volume, 125
W
waveforms, 106, 228–230, 232
WDM (Windows), 14, 53
Web DVD option, 21
web DVDs, 247, 271–273
webcam footage, 14, 33, 48, 53–59
Welcome screen, 9, 28
white adjustment, 133
Windows Media format, 289
Windows Media Player, 289
work area, 140–141
work area bar, 141
workflows, 126–127
workspaces
  considerations, 13
  customizing, 41–42
  dual monitor, 42
  overview, 9–10
  restoring, 30
  restoring default, 42
WYSIWYG preview area, 254–255

X
XAVC format, 288

Y
YouTube, uploading to, 281–284
YUV color values, 189

Z
Zoom In button, 95, 104
Zoom In icon, 101
Zoom Out button, 95
Zoom slider, 95
zooming in/out
  in Monitor Panel, 95
  Pan & Zoom effect, 151–155